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Analyzing Census Data with Excel – Course Guide 
Learn how to use Excel to summarize, analyze, and visualize Census data. 

 
Developed by Adam Hecktman, Microsoft Director of Technology and Civic Innovation for 
Chicago 
 
 

 

Module1: Basic Census Data Access and Table Formatting  
Module 2: Quick Census Data Analysis in Excel 
Module 3: Advanced Census Data Access and Hierarchical Charts in Excel 
Module 4: Advanced Census Data Analysis in Excel 
Extra Modules: Mapping Census Data in Excel 

Introduction 
The U.S. Census Bureau’s mission is to serve as the leading source of quality data about the nation’s 
people and economy. Whether you are looking for the most current economic indicators or for 
demographic and socioeconomic characteristics about your community and how they compare 
statistically to other areas, data from the U.S. Census Bureau are available online through a variety of 
tools.  

Every year, the Census Bureau publishes population, socioeconomic, housing and business statistics for 
all communities in the country. These data can be sorted by several characteristics such as age, sex and 
race, as well as different levels of geographies from the nation to areas below cities and towns. They can 
be charted, compared with other data (from inside or outside Census), and can be used to derive 
insights about the nation’s characteristics. 

Excel is a tool that many people are familiar with, and many people use every day. Excel can be 
leveraged to unlock the value of open data of all kinds, and it is particularly well-suited to transforming, 
analyzing, and visualizing Census data.   This course will show how to use Excel to access, manipulate, 
and visualize Census data.  It will also cover mapping that data, and tools for doing advanced statistical 
analysis.  
 

 

 

 

 

 

https://youtu.be/PovytwvMxTA?list=PLewV-zKXDZkgis1zeArTpQk5gzkyRWeiE
https://youtu.be/bcMLAwSUuCE?list=PLewV-zKXDZkgis1zeArTpQk5gzkyRWeiE
https://youtu.be/-qPmCQ1--Gk?list=PLewV-zKXDZkgis1zeArTpQk5gzkyRWeiE
https://youtu.be/ZsAlk-V2VIc?list=PLewV-zKXDZkgis1zeArTpQk5gzkyRWeiE
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MODULE 1: Basic Census Data Access and Table Formatting 
One very easy way to find basic data is by browsing the Community Facts feature found in the American 
Fact Finder (AFF).  American Fact Finder itself is an online, self-service tool designed to search a variety 
of population, economic, geographic, housing, education, and other types of data.  It is a very easy way 
to look for the data you may need. 

The Community Facts section shows you popular tables.  You can use the Guided Search feature to 
narrow down what you are looking for and have AFF suggest datasets for you. You can use the Advanced 
Search feature (which we will explore later) to build a query for your search.  In all cases, the data can be 
modified prior to being downloaded.  We will start with the Community Facts to find our data.   

Let’s say we simply want to see the population growth (or decline) of every county in the US over the 
last 6 years.  

Open http://census.gov in your browser. 

On the menu bar at the top, click on Data, and then go to Data Tools & Apps 

Select American Fact Finder, and click on Community Facts on the menu bar 

In AFF, look at the options you have on the left to find the data you are looking for 

We want population data, so choose population.   

Note that at the top, shaded in blue, you can see very common queries presented as a number for the 
geography you may be looking for.  In the case below, it is the Census 2010 Total Population.  You can 
select other common demographic data from the drop down.  But in this case, we want several years of 
population estimates. 

Select Annual Population Estimates 

 

 

https://youtu.be/PovytwvMxTA?list=PLewV-zKXDZkgis1zeArTpQk5gzkyRWeiE
http://census.gov/
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This will bring up a view of the table, and this is the table that we will open in Excel.  One of the nice 
features of this view is that you can modify the table before you even download it into Excel.  These are 
modifications that you can do in Excel after you download it as well, but sometimes it is nice to have less 
data to download.  We will make some modifications in this view, and the rest of the transformation we 
can do in Excel. 

Another way to search for data is to use the Advanced Search feature.   

Data Transformation 
One of the many benefits of using Excel is that it can be used to easily transform your data.  In this case, 
we are going to start modifying our table using the Census tools, and then we will put the finishing 
touches on the structure using Excel.  You can do all of this in Excel, but this example shows you useful 
methods for using both. 

You should now be seeing the table with April 2010 census data, and yearly population estimates.  Let’s 
say that we only want to download the yearly population estimates.   

Click on the Modify Table button 

 

Uncheck the April 1, 2010 Census and the Estimate base check boxes to modify the table. 

We will do the rest of the transformations in Excel, so click on Download. 

Choose “Use” and keep the Merge Annotations and Include Descriptive Elements checked. 

This will prepare the file for download to a zip file. 

Click Download 

Unzip the file called PEP_2016_PEPANNRES_with_ann.csv 

It is a best practice to get in the habit of saving your CSV files as an Excel Workbook right away.  This will 
avoid you wondering later why all the features of an Excel workbook are not available to you.   

Click on File/Save As, and choose the Excel Workbook (usually the top option). 

Name this file “Population” 

If you expand the columns in this spreadsheet, you will see right away that there are some columns and 
at least two rows we will not be using.  For example, the first two columns are geographic IDs.  We 
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won’t be using those, so it makes sense to delete them.  There is a top row with field names that we 
won’t be using, so it makes sense to delete that. 

Delete columns A and B with the geography IDs 

Delete first row with the Field Names. 

Delete the row with the total United States population information 

 

Your table will now look like this: 

 

Another best practice is to format your data as a table as soon as it is convenient.  Doing so is easy, it 
makes it more readable, and it gives the data some analysis features right off the bat.   

Click inside your data 

On the Ribbon, in the Styles section, click on Format as Table 

Pick a look that you like. 

It will confirm your table range, and keep the My Table Has Headers checked. 

You will notice that it gives arrows next to the headers.  Click on the arrows and you will see options for 
sorting and filtering your data.  This all comes with being formatted as a table!  This can be very useful in 
finding specific information.  For example, let’s say you want to find population data for Cook County. 
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Click on the arrow next to Geography 

Under Text Filters, start type “Cook” and hit OK 

But wait…There are several counties with Cook in the name, and you just wanted the one for Cook 
County, Illinois.  It would be better if the state were in its own column, separate from the county.  That 
way you could filter the state to Illinois and the County to Cook.  Let’s do a very common transformation 
with Census data.  Let’s break up a cell into multiple cells. 

Clear the filter by clicking on the arrow next to Geography again and choosing Clear Filter. 

Insert a row next to Geography (select Row B, right click and hit insert) 

 

Select the Geography column 

On the Ribbon, choose the Data Tab 

Click on Text to Column and note the preview, this is very useful 

You have some options for how you want to split up your column.  You can use a delimeter, meaning 
that Excel should split up the column based on a character (a comma in this case).  Or you can use a 
fixed width, which you sometimes need for data coming off of legacy systems like mainframes.  In this 
case, we are delimited by the comma that separates the county from the state. 

 Choose delimited and click next 

 Check the Comma as your delimiter (you can uncheck tab if you like) and click next 

 Look at the preview and verify it will look the way you want 

 Click Finish and accept the warning if it comes up 

You now have two columns, one for the county name and one for the state name.   

Rename the new column State 

Now you can do things like analyze population data changes for a single state.  For example, let’s say we 
just want to see the data for the state of Hawaii.   

Click on the drop down on the column header 

Under Text Filter, start typing Haw and you will see that only Hawaii is selected 
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Now you are seeing the population data corresponding to the four counties in Hawaii 

To go back to the full table, simply click on the drop down again and click on clear filter. 

You now have a fully functioning table.  Yet another best practice is to name your table.  This will make it 
obvious which data you are referring to when you do more advanced things like working with formulae 
and maps.  To name this table, simply click on the Design tab on the ribbon, and change the Table Name 
(in the Properties section of the ribbon) from Table1 to something more meaningful like 
PopulationCounty. 
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MODULE 2: Quick Census Data Analysis in Excel 
There are some very simple ways to create quick and effective analyses in Excel.  Later we will talk about 
more advanced analysis, but this section will focus on easy ways to derive insights from Census data.   

With a table like this, with year over year data, it is useful to see trends.  You can certainly quickly create 
a line chart that shows the trend for each state, but with so many counties, it would be difficult to see 
the trend for any particular county, as it would get lost in the chart.  This is where Sparklines come in 
handy.   

Sparklines are like little charts that live inside a single cells that can be used to visually represent and 
show a trend in your data. Sparklines can draw attention to important items, in this case population 
changes.  We can also use them to highlight the maximum and minimum values in the row. 

Create another column header in the column to the right of the population estimate for 2016 Name it 
“Trend”.  Notice that Excel automatically makes this part of the table for you, complete with formatting. 

 

Now, we will use this cell to create a Sparkline to see the population trend for that county. 

Click in the first cell under Trend 

On the ribbon, click on the Insert tab.  In the Sparklines section, you will see some options.   

Start with the Line Sparkline.  For Data Range, select the row of population estimates (C2:K2) 

That sparkline shows the trend, year over year, of the population for that county! 

Now, you can copy the sparkline for every county.   

Using a shortcut, you can select every cell in that column in that table by holding ctl+shift+end 

Now, from the home tab on the ribbon, in the editing section, choose fill/down. 

https://youtu.be/bcMLAwSUuCE?list=PLewV-zKXDZkgis1zeArTpQk5gzkyRWeiE
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Now you can quickly see the trends for each county!  That is a lot of  great insight in a single 
cell.  But it would be also very useful if you could see where the highs and lows are. 

Click on the Sparkline Tools Design tab on the ribbon. 

Note in the Show section that you have a variety of things you can show in each cell.   

Select the high point and low point 

You can even change the colors of what is the high point and what is the low point. 

Experiment with the style options 

 

 

Line charts are not your only option.  You can also use a column chart or a win/loss 
chart.   

You can experiment with these, but the trend is easiest viewed with the line chart 
in this scenario. 

 

There is a quick menu of tools called the Quick Analysis Tools that provides a trove of insights that you 
can add to your Census data.  You can instantly create different types of charts, including line and 
column charts, or sparklines. You can also apply a table style, create PivotTables, quickly insert totals, 
and apply conditional formatting.  Here, we will add icons, another way to do quick visual analysis right 
from within the cell.  To experiment with these, select the cells in the first row of data (the population 
estimates for Autauga County, Alabama)  
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Hit Ctl+Q, which is the keyboard the shortcut for Quick Analysis Tools 

In the mini toolbar, you can see you have a variety of options for doing analysis of your data. 

Hover over some of these to get a preview of what they do. 

Then click on Icon Set 

 

The icon set puts icons directly in the cell based on conditions.  In this example, it tells you if the 
population went significantly up, down or stayed relatively flat. 

Next, select the data on one of the other rows. 

Hit Ctl+Q again to bring up the quick analysis tool. 

This time choose Data Bar.  This shades the cell based on the data in that cell. 

Experiment with some of the other quick analysis options. 

These tools are actually examples of conditional formatting.  As you saw, conditional formatting rules to 
help you do things the built-in formatting rules can’t do.   To see what they look like, click on the 
Conditional Formatting in the Style Section of the Home tab.  Here you can not only see the wide variety 
of icons, data bars, and color schemes you can use, at the bottom (Manage Rules), you can manage how 
these visualizations are applied. 
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MODULE 3: Advanced Census Data Access and Hierarchical Charts in 
Excel 

In this section, we will explore two topics.  First, we will look at how to use the Advanced Search 
feature of the Census American Fact Finder.  Then we will modify and download a dataset, and 
use that to create a hierarchical chart (a chart that highlights data in multiple categories). 
 
Let’s say you want to understand the income gap between males and females with varying 
levels of education.  You can see that we are looking at three separate variables.  Income, male 
and female, and education level.  Let’s search the American Fact Finder using those variables to 
find exactly what we are looking for. 
 

Go back to American Fact Finder (http://factfinder.census.gov). 

Click on Advanced Search on the menu. 

On the left, click on Topics under the search options.   

Here you will choose the three topics mapping to the three variables. 

Start with male vs. female.  These are people, so click on People. 

Click on Age & Sex. 

Click on Sex. 

 
 

Notice that when you do that, it has added Sex to your search criteria in the box on the 
left marked “Your Selections”. 

Now we want to find Income.  Choose Income and Earnings. 

Choose Income/Earnings (Individuals).  It is added to your search criteria. 

Last, we want this data by levels of education.  Click Education 

Choose Educational Attainment 

https://youtu.be/-qPmCQ1--Gk?list=PLewV-zKXDZkgis1zeArTpQk5gzkyRWeiE
https://youtu.be/-qPmCQ1--Gk?list=PLewV-zKXDZkgis1zeArTpQk5gzkyRWeiE
http://factfinder.census.gov/
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Close the search box 

 

For this example we will look at national level data. You will not need to select a 
geography in AFF since the US is the default geography. However, if you are interested 
in conducting the same analysis for a different geography, you just need to use the 
Geography search option right below topics to select it. 

The second report gives you median earnings by sex by educational attainment.  Open 
this. 

 
Quite often, you will want to analyze or visualize census data across several different categories.  
You may be already familiar with using Excel charts to map single categories.  But there are 
several charts in Excel that are particularly good for hierarchal data.  An example of such data 
may be the average earnings (the data) for people with varying levels of education (one 
category), broken down by gender (a second category).  With a bit of cleaning, we can do that 
with this table. 
 

First, click Modify Table. 

Uncheck the Margin of Error column. 

Uncheck the education levels under Total, as we won’t be using those. 

We can structure the data further in Excel. 



 

12 
 

 
 
The view should look like this: 

 
 
Now, we can take this opportunity to learn another way to download data from Census.   

Click on Download, and instead of choosing Use (which downloads in CSV), choose View 
(which downloads in PDF or Excel). 

Select Excel as the presentation format. 
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Hit Download. 

Open the file. 
 
Your data is now exactly as you structured it, with a few extra columns and rows.  There is some 
verbiage which (once you read it), you can delete. 

Delete the first 8 rows above your table, and then all the rows of text below it (should 
start at row 16). 

 
 

 
Now, recall our best practice of saving these files as an Excel Workbook right away?  That 
applies even here where it is an Excel file already.  The reason is that this is actually an Excel file 
in compatibility mode.  This means it is meant to be used by someone with Excel 97 – 2003.  
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There are many…loads…of features that are available in more recent versions that you will want 
to take advantage of.  Saving this is a two-step process: 

File/Save As/type is Excel Workbook 

Close and re-open the file so that you are no longer in compatibility mode. 

 
Now let’s simplify this table a bit. 
Your table will look like this.   
 

 
 
At first glance, it looks fine, but actually there are some extra columns that are a little hidden.  
Start by deleting the first row. 

Delete the first row. 

Next, delete the row that says total 

Delete Column C 

Delete Column B 

At this point, you should have this: 

 

 
Now, again, a hierarchical chart has several columns of criteria.  We want to separate Male and 
Female into their own columns. 
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Add a column to the right of A 

Move the labels “Male” and “Female” into those columns, and delete the estimates for 
each. 

Label the Column “Sex” 

We are very close.  You should have: 

 

 
 

But what is with those green little triangles in the corner of the cells in column C?  That is Excel 
telling you it has found something that could save you hours of frustration later on.  Select those 
cells (or even just one of those cells) and you will see a little warning icon in the upper left of the 
selection.  
 

 
 
 
Click on it and you will see that it is saying that these could be numbers or these could be text!   

Choose convert to numbers. 

Now we are ready to make this look nice.  

Select your table and choose Format as Table 
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Get rid of those two extraneous row 

Give Column B the title “Education Level” 

Now you have a hierarchical table. 

 

 
 
 
There are charts in Excel 2016 that are particularly well suited to give you visual insights into 
data like this.  A treemap chart provides a hierarchical view of your data and makes it easy to 
spot patterns. The tree branches are represented by rectangles and each sub-branch is shown as 
a smaller rectangle. The treemap chart displays categories by color and can easily show lots of 
data which would be difficult with other chart types. 

 
Select your table 

Click on Recommended Charts on the Insert tab of the ribbon 

Scroll down and look at the previews 

Choose the Treemap 
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When you expand the chart, you will see many of the same options you see in other charts.  For 
example, you can click on Chart Title and give it a meaningful name.   
 
 
 

 
From the ribbon, you can also experiment with styles and layouts by hovering over the options.  
That way, you do not commit to the look you like until you select it: 
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You can also Treemap charts are good for comparing proportions within the hierarchy, however, 
treemap charts aren't great at showing hierarchical levels between the largest categories and 
each data point. A sunburst chart is a much better visual chart for showing that.  To see how this 
same chart looks as a sunburst chart: 

 

Click on the treemap chart 

From the Design tab on the Ribbon, choose Change Chart Type 

Select Sunburst 

 
The sunburst chart is actually quite similar to the donut chart.  It is as if you had a donut chart 
inside a donut chart, each level reflecting a category of your information 

 

 

 
If you want to move around the categories (for example, instead of earnings by education by 
gender, you want earnings by gender by level of education), a much more flexible and dynamic way 
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of looking at this data is through a pivot table.  That is beyond the scope of this particular course, 
but it opens up new worlds for manipulating your data. 

 

 
MODULE 4: Advanced Census Data Analysis in Excel 
 

The vast majority of time, Excel as-is it provides you with what you will need to access, combine, 
query, massage, transform, visualize, and otherwise play with your data using the visualizations, 
formulas, and functions.  There are, however, advanced tools for statistical analysis that you can 
turn on as an add-in.  You do not need to download anything, you just need to turn it on.  Doing so 
will give you tools for  
  
• Regression testing 
• Histograms 
• Anova, correlation, and covariance 
• Exponential smoothing 
• f-tests, z-tests, and t-tests 
• Fourier analysis 
• Moving averages, rank and percentile summaries 
• Sampling and a more sophisticated random number generator than the standard function 

  
Enabling the Add-in 
Going through all of these statistical functions and methods is beyond the scope of this training, so I 
will just give you a basic idea of how it can be used with a few examples.  We will enable the add on, 
and do some basic analysis on the Income spreadsheet. 
  

To enable the Add-in, click File, Options, and choose Add-ins.  

If you do not see the Analysis Tool Pack already in the list of add-ins, choose Excel-Add-
ins from the Manage drop down in the bottom and hit Go 

https://youtu.be/ZsAlk-V2VIc?list=PLewV-zKXDZkgis1zeArTpQk5gzkyRWeiE


 

20 
 

 
  
  

You will see a list of available add-ins.  Check Analysis Tool Pack and click OK. 
Now, when you click on the Data tab, you will see the Analysis Tool Pack. 

  
Descriptive Statistics 
Descriptive statistics describe the main features of a Data set.  They are the basic statistics you 
would generally want to start with, even if you are doing more sophisticated analysis of data.  
Descriptive statistics provide, for example, information about the central tendency, variability, and 
overall shape of your data in a few clicks. 

  

Click in the Income table 

Choose Data Analysis Tools from the Data tab 

Choose Descriptive Statistics. 
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Give it the input range (which should be the median household income, including the 
column heading at the top, and Puerto Rico at the bottom). 

For this example, have it group the data by column  

Output the data to a New Worksheet Ply name it Descriptive Stats 

Check Summary Statistics 

Hit “OK” 

 
You will now have a new tab called Descriptive stats.   Again, these are useful for your first glance at 
the data to initiate your statistical analysis. 
 

 
 
Histogram 
A histogram is a chart that tells you the number of occurrences of a value or range in a data set. You 
may recall from school that sometimes letter-grades were distributed in odd boundaries.  Chances 
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are good that your teacher used a histogram to determine those letter-grade boundaries and the 
number of scores that fell in the range.  
 
In this case, we are going to look at how the median income data is distributed.   We will create a 
column of “bins” where we want the data to fit.  For example, we want a bin representing median 
income of $9,000 and under, another between $9,001 and $12,000, another between $12,001 and 
$15,000, etc. 
 

Somewhere in the spreadsheet, enter in separate rows on a column the bin numbers 9, 
12, 15, 18, 21, 24.  I picked these ranges arbitrarily.  

  

 
  

  
  

Now, go to the data tab, and click on Data Analysis Tools. 

Click Histogram and the following dialog box will appear: 
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Select the income data for the input range (no need to include the label, unless you want 
it) 

Select your Bins for the Bin  

Select some empty space on your spreadsheet for the output range 

Click the Chart Output box 

Click OK 

  
And that is it.  You now have a histogram 

 
  
Sampling 
The Data Analysis tools make it super simple to get samples from a population.  Although this is a 
very small amount of data (51 data points), you can imagine if you were doing research on a data 
set with hundreds, thousands, tens of thousands, etc. of data points.  Getting a random sample 
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from such a large dataset is not that easy.   So even though this is a trivial example, it is good to 
know how it is done. 
  

Choose Data Analysis Tools from the Data tab 

Choose Sampling. 

Give it the input range of state data 

Tell it how big your sample size should be in Number of Samples.  Try 5 

Tell it where you want it to show the output 

 

   
Now you have your sample, with no complex formula, no macros, and no repetitive 
operations required.  
 

EXTRA MODULE: Mapping Census Data in Excel 
(Not available on video) 
 
Let’s say we want to plot on a map the median household income for each state, along with the number 
of people in each state that have completed high school education.   

We can leverage the Community Facts in the American Fact Finder again to find the data that we need. 
Let’s start with a very simple table, a comparison of median household income per state found in the 
Income section. 

Click on the Community Facts from the top menu on American Fact Finder 

Click on Income on the left 

Choose Compare States for Median Household Income 
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From the table page, choose Download 

Select Use Data 

Click Download 

Unzip to your computer and open the CSV file 

 

Again, apply your best practice of saving this CSV file as an Excel Workbook file right away. 

File/Save As/Excel Workbook with a meaningful name 

Next, we can delete columns we won’t be using.   

Delete  the columns containing GEO.id, GEO.id2, GCT_STUB.target-geo-id, GCT_STUB.target-geo-
id2) , and the margin of error column, HC02.   

Also delete that first data row for the overall United States (row 2).  

 
Let’s give our headers useful names.  Name the header of Column A “State” and Column B, “Median 
Household Income”. 
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Next, let’s turn this into a table to access all the table features.   

Click on Format As Table 

Pick your favorite style, and make sure the “My Table Has Headers” box is checked. 

Give your table a meaningful name by changing the “Table1” in the Table Name Box (in the Table Tools 
Design tab) to something meaningful: 

 

 

Let’s find the high school education data and put it on another tab in this workbook 

Click on Community Facts 

Select Education 

Click on Compare States for People Who have Completed High School 
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Again, if your data transformations are simple, you can do them before you even download the data.   

With the table up, click on the Modify Table button. 

 

Again, you have the ability to modify the table by deleting elements, moving elements, even transposing 
rows and columns.   

We are simply going to uncheck the Margin of Error column. 
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Download as before, and extract the file into Excel as a CSV file. 

Remember to save this as an Excel Workbook right away. 

Delete columns A through F, as before. 

Delete the row showing the total for the United States 

Names your headers State (or StateEducation), and Percent Completed HS. 

 

 

Click on Format as Table from the Styles section of the Home tab on the ribbon.  

Ensure that “My table has headers” is checked, and hit ok. 

Give this table a meaningful name by changing Table Name in the Table Tools Design tab of the 
ribbon from Table1 to something you like. 
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To minimize jumping in and out of multiple workbooks, move this spreadsheet into the workbook with 
the Income data.   

Right click on the tab at the bottom with the name of your current spreadsheet.   

I’ve named mine “Education” 

Choose Move or Copy… 

 

 

You will see that you can change the workbook you can copy or move this to.   

Click on the drop down and select the first spreadsheet you had been working on.   

I named mine “Income”.  
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Now you will have one workbook with two tables.  You can verify that the tables have been named the 
way you want by choosing the tab with the data, clicking in the table, choosing the Design tab on the 
ribbon and looking at the table name: 

 



 

31 
 

 

Now we are going to create a 3D Map to visualize both the income and the education levels across 
the states.   3D Maps allow you to take geographical (and time) data and turn them into maps, and 
even create videos to share and post those maps. 
  

Click 3D Map from the Insert tab 
  
First time you do this with your data, it will say on the bottom "loading model" and this may take a 
while for very large data sets, but it only happens once.  When it says loading model, it is referring 
to a data model. 
  
A Data Model is an approach for integrating data from multiple tables.  Effectively, what you are 
doing is building a relational database inside an Excel workbook, without having to have database 
expertise. Within Excel, Data Models are used pretty much without you having to know anything 
about them.  They are used in Maps, PivotTables, Pivot Charts, and Power View reports, etc.  But 
today, we are just going to build a map.   
 
You will have a screen that looks like this: 
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Let's talk about some terminology.  On the upper right, you will see the fields in your tables.  You 
should now be able to appreciate the fact that you named your tables something useful!  
 
Layers 
 
To the right of that are the options for the layer.  You create layers that show specific data on your 
map (like the number of graffiti requests).  You can combine layers on top of layers, and then build 
scenes from those layers.  When you have a time dimension (such as something that happens every 
day, week, month, etc), map scenes are like scenes in a movie, with transition effects and all.  Then, 
you can combine scenes into a tour.  Here we only have spatial data. 
 
The first decision you need to make is the type of map we want to create.  We can choose a column 
chart, a stacked column chart, a bubble chart, a heat map, a shaded region, even add a custom map 
type.  Let’s start with a stacked column chart so that we can have a column whose height represents 
the median income for the state. 
 
The second decision you need to make is which fields in your table you want to use to denote 
location.  Excel Maps make it easy to do, but it is an important question to consider.  It relates to the 
question of what you want your analysis to answer.  In our case, want to review data at the state 
level.   But Census is rich with data for cities, counties, metropolitan statistical areas, census tracts, 
etc.  Some datasets may even contain latitude/longitude coordinates.  Excel’s 3D maps can handle 
all of them. 
  
In this case, we are going to use the state data for median income.  Excel has already predicted that 
you want to use State, and that the field named State refers to a US state.  Go ahead and delete that 
by hitting the x next to it so you can see how to do this manually. 
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You could add the geography field this way:  
  

In the Location box of the Layer options, choose +Add Field, and add State from the Median 
Income table 

 
Now, let’s add data to represent the height of that column. 

In the Location box of the Layer options, choose +Add Field, and add State from the Median 
Income table 

 
 
 
Just as with tables, it is always a best practice to name your layers.  Whatever you name your layer 
will also show up in a legend that gets created automatically for you.  In the upper part of the box, 
click on the pencil to the right of the label Layer 1 and give it a meaningful name.  We can call it 
Median Income: 
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To make it obvious which state is which, use Map Labels: 

Click on Map Labels from the ribbon 
 
Take a few minutes to explore this map.   
 

Zoom in using the mouse wheel or using the + and - buttons 

Tilt up and down using the arrows 

Generally explore the map by moving around 

  
When you hover over one of the data points, you see text from that data point in the form of what 
is called a custom card.  You can create custom cards that show all kinds of data.  You can also add 
your own annotations.  Let’s annotate Mississippi and point out that it has the highest median 
household income.  
 

Right click on the column in Mississippi and choose Add annotation 

In Title, type Highest Median Income 

In description, note that you can type anything you want, add a field, or insert an image.  

Here we will add a field, and select both data points. 

 
Feel free to add other annotation.  Let’s add a second layer with a different chart type, this one a 
shaded region chart. 
 

Click on the Add Layer button to get your next layer.  Note that the first layer will still be visible 
(unless you click on the little eye icon next to the layer name). 

In the Location box of the Layer options, choose +Add Field, and add State from the Education 
table 

Change the chart type to the Shaded Region chart  
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Now, let’s add data to represent the shading within the region. 
 

In the Value box of the Layer options, drag Percent Completed HS into the value field 

 
You now have a visualization that shows you which states have a relatively higher percentage of 
people completing high school.  But you can make it even more clear.   
 

Click on Layer Options and change the color scale to 20% 

Rename the layer form “Layer 2” to something more relevant like “Percent Completed High 
School” 
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On the lower left, you will see the legends clearly.   

Move them it so that it is in the upper left (in the sky). 

 
Scenes 
Scenes allow you to visualize your map like a movie.  You can even add a soundtrack!  In this case, 
we are going to build two scenes: one that shows just the shaded region map that denotes the 
percent completed high school, and then a second scene that adds the median income.  We will 
combine the scenes into what is called a “tour”, and each scene will have different visual effects to 
allow you to see it better. 
 
  

In the Layer Pane, click on the eye icon to hide the Median Income layer. 
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On the left side of the screen, you will see your tour pane with one scene. 

Click on Scene Options in the ribbon 

Give the scene the name Percent Completed High School 

 

 
 

Change the transition duration to 5 seconds.  This is how much time the scene spends on this 
particular view of your map. 

Assign an effect (I suggest Dolly). 

You can test your work by clicking on the Play Tour button on the ribbon towards the left side. 
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Now let’s create our second scene.  We will add to this shaded region the column chart of 
median income. 
 

Choose New Scene from the ribbon (or right click on the first scene) 

Unhide the Median Income Layer by clicking on the eye icon 

Click on Scene Options and name this scene “Add Income Data” 

Change the transition duration to 5 seconds 

Assign a different effect (I suggest Circle) 

 

 
Play the tour 

 
You can see that when the income data points come in, the movement of the map changes. 
 

Custom Maps and Local Census Data 

This section brings together many of the skills you have learned so far, and adds two more.  
Census data is not just about national statistics.  There is an abundance of data at the state, 
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county, city and town level.  You can also access data for areas below these levels such as zip 
codes, census tracts, block groups, and blocks.  But how would you know what a census tract 
looks like, and how it relates to other geographic areas? This is where custom maps come in. 

Let’s say we want to map both the 10 year population change and the 10 year housing change 
for all of the census tracts in the state of Illinois.  We need two things.  First, we need the data.  
Second, we need a way to tell Excel where those census tracts are on a map.  Census has both of 
these. 

First, let’s get the data and bring it into Excel.  We are looking for 2000 to 2010 census tract 
population changes.  You can use the search options in American Fact Finder.  But for simplicity, 
the spreadsheet can be loaded here: 
http://www2.census.gov/programs-surveys/decennial/tables/time-series/tract-change-00-
10/censustract-00-10.xlsx  

Open this spreadsheet and we will simplify it. 

Delete all columns but TRACT10, NPCHG, and NHCHG.   

These are the census tract number, the population change over 10 years, and the 
housing change over 10 years. 

Format it as a table in whatever style you like 

Save it as an Excel Workbook somewhere on your computer  

 

 

Now, we need something that tells us what all those tracts actually look like on a map of the 
state of Illinois.  Census maintains files called KML or SHP files that can be used for this purpose.   

From Census.gov, choose Geography from the menu bar at the top of the page 

Choose Maps & Data 

Choose TIGER products 

Click on KML-Cartographic Boundary Files. 

These are the files that you can use not only in Excel, but a variety of mapping tools. 

https://na01.safelinks.protection.outlook.com/?url=http%3A%2F%2Fwww2.census.gov%2Fprograms-surveys%2Fdecennial%2Ftables%2Ftime-series%2Ftract-change-00-10%2Fcensustract-00-10.xlsx&data=02%7C01%7Cadamh%40microsoft.com%7C6ce5ef58998140a1f1b708d4d2fab5de%7C72f988bf86f141af91ab2d7cd011db47%7C1%7C1%7C636365421615769556&sdata=mSMbARiVTU1UyowLSB2qJkyttLfv4FwhSlsGS1YUAXg%3D&reserved=0
https://na01.safelinks.protection.outlook.com/?url=http%3A%2F%2Fwww2.census.gov%2Fprograms-surveys%2Fdecennial%2Ftables%2Ftime-series%2Ftract-change-00-10%2Fcensustract-00-10.xlsx&data=02%7C01%7Cadamh%40microsoft.com%7C6ce5ef58998140a1f1b708d4d2fab5de%7C72f988bf86f141af91ab2d7cd011db47%7C1%7C1%7C636365421615769556&sdata=mSMbARiVTU1UyowLSB2qJkyttLfv4FwhSlsGS1YUAXg%3D&reserved=0
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Click on Census Tract under State-based Files. 

Select Illinois 

This will give you a zip file that you should extract to your computer.  The one we are most 
interested in is the KML file.  We will import that into Excel. 

Now, to bring it all together!   
In the spreadsheet you just created, choose 3D Map from the Insert tab and add a map. 

For location, choose TRACT10.  But you need to tell Excel what a tract looks like, right? 

Set the location type to be a custom region and you will be prompted to import the 
region. 

 
 
Click Yes and point it to the KML file that you downloaded and unzipped. 

Give it a friendly name, if you wish 

Now, the region name in this KML file is TRACTTCE, so select that 
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Now, let’s give it a more professional look.   

In the map type, choose the shaded region type. 

 

You are starting to see the census tracts come alive. 
For the final flare, drag NHCHG (number household change) and NPCHG (number 
population change) to the value field.  

Name the Layer something useful 

You now have a custom map with data by census tract 
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Where to go from here 
 
This course has barely scratched the surface both in terms of the useful data provided by US 
Census and the tools in Excel that you can use to work with that data.   We explored just a few 
data sets and a few ways to use it.  However, the use cases are almost limitless.  Here are just 
a few examples of how data from the Census Bureau are used: 
 

• Decision making at all levels of government. 
• Forecasting future transportation needs for all segments of the population. 
• Planning for hospitals, nursing homes, clinics and the locations of other health 

services as well as for distributing medical research. 
• Designing public safety strategies and creating maps to speed emergency services to 

households in need of assistance. 
• Planning health and educational services for people with disabilities. 
• Attracting new businesses to state and local areas. 
• Planning for school construction and other projects. 

 
Further, Census provides a myriad of tools for finding the data that you need, accessing it with 
a variety of applications and devices, and incorporating it into research and other data-heavy 
activities.  Go to http://census.gov to discover more.  
 
Excel provides numerous easy to use tools for taking that data and combining it with other 
data, manipulating the data through formulae and functions, visualizing the data, pivoting it 
to understand the data in new ways, and sharing the data with a large number of other data 
sources and stores.  It provides ways to help users not only gain insights from the data, but 
also to collaborate on it.  I hope that this course has inspired you to explore further on your 
own. 

   

http://census.gov/
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